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What is PROSHOTS Basics 
Software? 

 
KODAK PROSHOTS Basics Software is a digital proofing and ordering system for professional 
photographers. The software lets you: 

y review images. 

y do basic image editing. 

y order prints and proofs from a participating lab. 
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Key Features 
 

y Easy installation 

y Short learning curve 

y Scanned film and digital image workflows 

y Online registration with a participating KODAK PROSHOTS Lab 

y Ability to view a representation of the ordered image 

y Zoom, skew, and rotate editing functions 

y Placement of an image within a print crop 

y Ability to update the software and lab catalogs online without installing new software 

y Display of lab pricing and order totals 

y Upload or mail orders 

y Ability to place reorders 
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Hardware Requirements 
 

Operating System 

  

MICROSOFT WINDOWS 2000 Professional, MICROSOFT 
WINDOWS XP Home,  MICROSOFT WINDOWS XP 
Professional with the following: 

y Processor - 600 MHz PENTIUM II minimum, 2.0 GHz 
PENTIUM 4, recommended 

y  Free disk space - 1 GB minimum 

y  Memory - 128 MB SDRAM minimum, 1 GB DDR 
recommended 

  MAC OS 10.3 with the following: 

y Processor - G4 

y Free disk space - 1 GB minimum 

y Memory - 128 MB minimum, 512 MB recommended 

Video Card 4 MB Video Card capable of supporting 1024 x 768 x 24 bit 
color 

Peripherals  20x CD-ROM drive, 8x CD Reader/Writer 

Internet Access  MICROSOFT Internet Explorer v6.0+ or NETSCAPE 6+r, 
56K v.9.0 modem or high-speed connection (cable modem or 
DSL connection), email 
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Software Updates 
Each time you start the PROSHOTS Basics Software, the software checks if your computer is 
connected to the Internet. If the software detects an Internet connection, it checks for any updates 
and automatically downloads them to your computer before it starts the software. 

Updates to JAVA Web Start, which is used to automatically update the PROSHOTS Basics 
Software, is not automatically updated. For updates to JAVA Web Start, go to: 

http://www.java.com 

http://www.java.com/
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Trademarks and Copyrights 
© Eastman Kodak Company, 2004. 

All rights reserved. The contents of this publication may not be reproduced in any form without the 
permission of Eastman Kodak Company. 

Kodak and ProShots are trademarks of Eastman Kodak Company. 

 
Help version 024004 
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Using Help 

Using Help 
Click: To: 

Contents 
tab 

View the contents of Help. Select a book to view the topics contained 
within it. Select a topic to display the topic. 

Index tab Search using keywords or phrases. Click on a keyword in the left 
pane, and the topic containing information about the keyword 
appears in the right pane. 

Search tab Search for words that are in the Help system.  

 View additional information. 

 Display a related topic. 
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Using the Search Tab 
The Search tab lists words that are used in the content of the Help topics. Scroll through the list of 
words, and click the word that matches your search criteria. If the word appears in more than one 
topic, click the numbers that appear after the word to view the additional topics. 

To narrow your search, click the letters at the top of the Search pane. 
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Using PROSHOTS Basics Software 
 

PROSHOTS Basics Software 
Workflow 

The following is a workflow to create and send a typical proof or print order to your lab using the 
PROSHOTS Basics Software: 

Find the images for the order. 

Add images to the Order Builder. 

Select a lab catalog. 

Make edits to your images. 

Create a proof order or a print order. 

Add Services to a print order. 

Print a copy of your order. 

Send the order to the lab. 
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Menus 
Menus 

The PROSHOTS Basics Software has the following menus. Click a menu for a description of its 
options: 

File Menu 

Edit Menu 

View Menu 

Tools Menu 

Help Menu 
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File Menu 
 

Option Purpose 

New Creates a new order. 

Open Lets you open a previously 
saved order. 

Close Closes the order without 
saving your changes. 

Save Lets you name an order and 
save your changes to it.  

Save As Lets you save the order with a 
different name. 

Order 
Summary 

Lets you print a copy of your 
order.  

Place 
Order 

Lets you review your order 
and select your shipping 
method. 

Order 
Properties 

Opens the Order Properties 
Editor where you can add 
services that will be applied to 
each image in your order. 

Exit Closes the PROSHOTS 
Basics Software 
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Edit Menu 
 

Option Purpose 

Image Editor Opens the Image Editor where you can make 
edits and add services which are applied to every 
print you order of that image. 

Select All Selects all the images in the Original Images 
pane. 
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View Menu 
 

Option Purpose 

Prices>Lab Displays the unit price for each 
product in the lab's catalog. 
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Tools Menu 
 

Option Purpose 

Print Order Status View a status of your print orders 
from the lab. 

Lab Maintenance Add or remove a lab or change your 
lab registration information. 

Options>Proxy Setup Access the Internet through a proxy 
server. Contact your network 
administrator to complete this setup. 
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Help Menu 
 

Option Purpose 

Contents 
and Index 

Opens a list of help topics. 

Getting 
Started 

Gives you the basic steps to 
create and send your first 
order using the PROSHOTS 
Basics Software. 

About Lists the software version. 
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Importing Images 
 

About Images 
The PROSHOTS Basics Software accepts TIF and JPEG image files. These image files can be: 

y high resolution digital camera images. 

y high resolution scanned film images from your lab. 

y proxy images from scanned film downloaded from your lab. 

You must convert any DCR files from a digital camera to either TIF or JPEG image files before 
you import them into the PROSHOTS Basics Software. 

You can combine scanned images and digital camera images in the same order. 

  

Importing Digital Camera Images 

Importing Scanned Film Images 
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Importing Digital Camera Images   
1. Click Find Images. 

2. Click the Studio Images tab in the Find Images dialog box that opens. 

3. Navigate to the folder containing the images, and click OK.  

 
Thumbnails of the images appear in the Original Images window. 

 
  

NOTE: You can import digital camera images from multiple folders into the Order Builder. 
  

About Images 
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Importing Scanned Film Images 
After your scanned film images are returned from the lab, they can be imported into the 
PROSHOTS Basics Software so that you can add them to your orders.  

NOTE: Contact your lab for information on how to send your film to them for scanning. 
To import scanned images into the Order Builder: 

1. Click Find Images. 

2. In the Find Images window that opens, click the Scanned Film Images tab. 

3. Click the appropriate lab in the Registered Labs list, and then click the order that contains the 
images you want to import, or click Have Disk and locate the images on your computer or a 
network drive.    

4. Click Import. 

The images appear in the Original Images pane of the Order Builder. 

  

About Images 
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Creating Orders 
 

Adding Images to the Order Builder 
The first step in building your order is to add the images you want to include in your order to the 
Order Builder. 

1. Select the Original Images you wish to add. 

2. Click Copy. 

  

Tips for Selecting Images 
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Tips for Selecting Images 

You can select the Original Images to add to the Order Builder in several ways: 

For WINDOWS Systems: 
y Hold down the Ctrl key, and then click each image to select a group of individual images. 

y Select the first image, press the Shift key, and then select the last image. All images between 
the 2 are selected. 

Tip: Use the scroll bar to view all the Original Images. 

 

For MACINTOSH Systems: 
y Hold down the Command key, and then click each image to select a group of individual 

images. 

y Select the first image, press the Shift key, and then select the last image. All images between 
the 2 are selected. 
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Creating a Proof Order 
You can order proofs to show to your customers. If your lab offers the option, you may also order 
bound proof books. 

IMPORTANT: You cannot combine finished prints and proofs in the same order. 
1. To view the lab's prices, select Display Lab Prices from the View menu. 

2. Click the Proof tab. 

Tip: Click the arrows to expand, or hide the panes in the window. 
3. Make sure that you have selected the appropriate lab catalog. 

4. Click the images you want to include in your proof order, and then click Add. 

5. Click the arrows to adjust the order quantity. 

6. Click Edit, and then use the Move Up, Move Down, and Exclude buttons to make additional 
changes to your order. 

7. To print a copy of your order summary, select Order Summary from the File menu, and then 
click Print. 

8. Send the order to your lab. 

  

Selecting a Lab Catalog 

Sending an Order to a Lab 
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Creating a Print Order 
IMPORTANT: You cannot add prints and proofs to the same order. 
1. To view the lab's prices, select Display Lab Prices from the View menu. 

2. Click the Print tab. 

Tip: Click the arrows to expand or hide the panes in the window. 
3. Click the images you want to include in your print order, and then click Add.  

4. Make sure that you selected the correct lab catalog. 

5. Click the arrows to adjust the print order quantity. 

6. Add any services you want for your order. 

7. To print a copy of your order summary, select Order Summary from the File menu, and then 
click Print. 

8. Send your order to the lab. 

  

Adding Services to a Print Order 

Sending an Order to a Lab 
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Using the Image Editor 
Using the Image Editor 

Use the Image Editor to see how your images appear ordered in different sizes or with zoom, rotate, 
or skew functions applied to the images. 

To open an image in the Image Editor: 

y Select the images, and click Edit Selected. 

To save your changes: 

y Click Save. 

 

What do you want to do? 

Use the Zoom 

Rotate an Image 

Skew an Image 

Preview Images in Different Sizes and Orientations 

  

Tips for Selecting Images 
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Using the Zoom Function 
In the Image Editor, you can zoom in or out on your image. 

Click: 

to zoom in. 

to zoom out. 

Click the arrows around the image in the Crop Window to move or center it in the print crop. 

Tip: You can also click the image and drag it to change its position in the print crop. 
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Rotating Images 
In the Image Editor, you can rotate images in 90° increments clockwise or counterclockwise. 

NOTE: Make sure that your images are always rotated to the "heads-up" position. 
Click: 

 to rotate your images 90° counterclockwise. 

 to rotate your images 90° clockwise. 

Click the arrows around the image in the Crop Window to move or center it in the print crop. 

Tip: You can also click the image and drag it to change its position in the print crop. 
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Using the Skew Function 
In the Image Editor, you can tilt your images clockwise or counterclockwise in 1° increments up to 
15°. 

Click: 

 to tilt the image counterclockwise. 

 to tilt the image clockwise. 

Click the arrows around the image in the Crop Window to move or center it in the print crop. 

Tip: You can also click the image and drag it to change its position in the print crop. 
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Previewing Images in Different Sizes 
and Orientations 

Use the Print Preview options in the Image Editor to see how your images appear ordered in 
different sizes and orientations. The Print Preview  lets you set the rotation and crop for the image 
once so that all the prints you order of that image have the same rotation and crop.  

NOTE: Use the Print Editor to make changes to individual prints. 
To preview your images in different sizes and orientations: 

y Click an image preview size, and click one of the orientation buttons. Select from: 

  Vertical 

  Horizontal 

  Square 

Click the arrows around the image in the Crop Window to move or center it in the print crop. 

Tip: You can also click the image and drag it to change its position in the print crop. 
  

Using the Image Editor 
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Selecting a Lab Catalog 
About Lab Catalogs 

Lab catalogs define the products and services offered by your lab and their prices. A lab may have 
several catalogs from which you can choose. Since labs frequently update their catalogs, if a newer 
version of the catalog is available online, each time you start a new job you are prompted to load 
the new catalog if you are connected to the Internet. You must be registered with a lab to use its 
catalog. 

NOTE: After a catalog expires, you can use it to finish any current orders. However, you cannot 
use the expired catalog to start new orders. 
  

Selecting a Lab Catalog 
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Selecting a Lab Catalog 
After you have added your images to the Order Builder and made any changes to the images in the 
Image Editor, select the appropriate catalog from your lab. 

To select a lab catalog for your order: 

1. Click Select Lab Catalog. 
2. Double-click the catalog you wish to use. 

NOTE: If you are connected to the Internet, a message may appear that a newer version of the 
catalog is available. Click Yes in the message to install the new version. 

3. Click OK in the Select Catalog dialog box. 

The products and services offered by the lab's catalog appear to the left of your images in the Order 
Builder. 
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Adding Services 
 

About Services 
If your lab supports these options, you can add services such as canvas mounting, logos, or 
retouching to your prints. You can add services at the following levels of the order process: 

Print level - spray, mounting, or finishing 

Image level - retouching 

Order level - delivery and payment options 
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Print Level Services 
Print level services are services applied to a particular print.  

To add print level services: 

1. Click the amount in the Srv Cost column next to the print you added to your order. 

 
2. Click the tabs in the Services Editor dialog box that opens to view the print level services 

available from your lab. 

3. Make your selections, and click Save. 
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Adding Services to an Image 
When you add image level services, those services are added to every print of that image in your 
order. 

To add image level services: 

1. Make sure that you have selected a catalog.  

2. Select the images in the Order Builder to which you want to add image level services. 

3. Click Edit Selected. 

4. Click Services. 

5. Click the tabs in the Services Editor dialog box that opens to view the print level services 
available from your lab. 

6. Make your selections, and click Save. 

  

Using the Image Editor 
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Adding Services to an Order 
When you add services to an order, those services are added to every print in the order. Add these 
services after you complete building your order and you are ready to send it to your lab. 

To add order level services: 

1. Select Order Properties from the File Menu. 

2. In the Order Properties Editor dialog box that opens, click Services. 

3. Click the tabs in the Services Editor dialog box that opens to view the print level services 
available from your lab. 

4. Make your selections, and click Save. 
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Sending Orders to a Lab 
About Sending Orders 

You can upload your order to your lab via the Internet, or you can copy the order file to a CD and 
mail it to your lab. However, your lab may set limits on the size of an order that you can send to 
them via the Internet. Check with your lab for their guidelines on uploading or mailing orders. 

If the combined high-resolution image file size in the order is too large to be uploaded, the Send 
Order via Internet option is not available in the Place Order dialog box. 

  

Sending an Order to a Lab 
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Sending an Order to a Lab 
1. Click Place Order. 

2. In the Place Order dialog box: 

y type a name for the order in the Order Name box. 

y select the shipping method for receiving your finished prints from the lab. 

y type the order number in the PROSHOTS Order ID box. 

NOTE: Use the order numbering conventions outlined in the information you received from your 
lab. 
y Click the method you will use to send your order to the lab.  

IMPORTANT: If the Send Order via the Internet option is not available, the order size is too large 
to upload. You must copy the order to a CD and send it to your lab. Click Browse; and select the 
folder where you want the order stored. 

3. Click OK. 

4. To add services to your order, select Order Properties from the File menu; and add the Services 
to your order. 

If you are not connected to the Internet, your order is saved in the My Documents folder on your 
desktop. When you connect to the Internet, your order is automatically sent to your lab. 

If you are sending your order to your lab on a CD, copy your order from the folder you specified to a 
CD; and follow the instructions provided by the lab for mailing. 

  

Adding Services to an Order 

About Sending Orders 
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Tips and Troubleshooting 
About Tips and Troubleshooting 

If you have a problem or a question about the software or working with your lab, check the 
following topics for a possible solution. If you cannot find the answer, see Getting Help. 

Changing or Working with Multiple Labs 

Catalog Does Not Contain Necessary Sizes or Services 

Software is in Demo Mode 

Changes to Digital Images 

Adding Images from Network Drives or Other Media 

Backing Up Your Orders 

Images Do Not Display Sharply on Your Monitor 

Changing Images After the Order is Created 

Adding Both Prints and Proofs to Your Order 

Color Management 

Using PROSHOTS Basics with PROSHOTS Studio Software 

Obtaining Software Updates 

Is an Internet Connection Required to Use the Software? 
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Changing Labs or Working with 
Multiple Labs 

Problem 

You need to change labs or work with more than one lab. 

Solution 

To add a lab, select Lab Maintenance from the Tools menu, and then click Add New Lab. 
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Catalog Does Not Contain Necessary 
Sizes or Services 

Problem 

The catalog does not contain the print sizes or services you need for your customers. 

Solution 

The print sizes and services are set by the lab. Contact the lab to request special sizes or services. 
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Software is in Demo Mode 
Problem 

You have installed the PROSHOTS Basics Software, but you are in demo mode and cannot 
complete an order. 

Solution 

Contact a KODAK PROSHOTS participating lab to obtain a user ID and password. Go to: 

http://www.proshots.net/newuser/labs/index.php 

http://www.proshots.net/newuser/labs/index.php
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Changes to Digital Images 
Problem 

Changing the original high-resolution image does not change the thumbnail image shown in the 
PROSHOTS Basics Software. 

Solution 

The edits you make are not saved to the original image. To edit a high-resolution image, make a 
copy of it with a new name, edit the copy, then import it into the PROSHOTS Basics Software as a 
new image. 
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Adding Images from Network Drives 
or Removable Media 

Problem 

You have images on multiple media or network drives that you wish to import into the PROSHOTS 
Basics Software. 

Solution 

You can import images from a network drive or other media. However, the images must all be 
available when you send the job to the lab. For example, you can import images from a single CD, 
but you cannot change CDs when the software creates a zipped file of the ordered images to send to 
the lab. 

  

  



 43

Backing Up Your Orders 
Problem 

You need to save a backup copy of your order. 

Solution 

On WINDOWS systems, your orders are saved to C:\Documents and Settings\KODAK 
PROSHOTS Basics Software. 
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Images Do Not Display Sharply on 
Your Monitor 

Problem 

Images viewed in the PROSHOTS Basics Software do not appear sharply on your monitor. 

Solution 

The images you view in the software are low-resolution images. The prints you receive from your 
lab will be high-resolution, high-quality images.  
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Changing Images After the Order is 
Created 

Problem 

You want to make changes to your images such as moving, deleting, or archiving them after you 
create your order. 

Solution 

Do not make changes to your high resolution, digital camera images between the time you begin 
creating the order and the order is complete and sent to the lab.  
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Adding Both Prints and Proofs to 
Your Order 

Problem 

You want to send an order to your lab that consists of both prints and proofs. 

Solution 

You must create separate orders for prints and proofs. Labs offer a much higher level of quality 
control on print orders, so their workflows do not let them combine orders. 
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Color Management 
Question 

How are images color managed by the PROSHOTS Basics Software? 

Answer 

The software does not color manage the images. For high-resolution digital camera images, the 
color management embedded in the images is printed by the lab. However, the lab may have color 
restrictions. Check with the lab for more information. 

The lab controls the color management for scanned film images. 
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Using KODAK PROSHOTS Basics 
Software with KODAK PROSHOTS 
Studio Software Suite 

Question 

Can I use PROSHOTS Studio Software with the PROSHOTS Basics Software? 

Answer 

You can install and run both programs on the same computer, but you must start and complete an 
order in the same program. 
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Obtaining Software Updates 
Question 

How do I get updates to the PROSHOTS Basics Software, and how often is the software updated? 

Answer 

Updates occur automatically. If an update is available when you log onto the Internet, the software 
checks for updates and installs them. Updates occur periodically.  

Updates to PROSHOTS Basics Software do not include updates to JAVA Web Start, which 
operates with the software. For more information on updates to the JAVA Web Start. go to: 

http://www.java.com/ 

  

  

http://www.java.com/
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Is an Internet Connection Required to 
Use the Software? 

Question 

Can you install and use the PROSHOTS Basics Software without an Internet connection? 

Answer 

You can create orders without being connected to the Internet. However, you must have an Internet 
connection to: 

y install software updates. 

y register with a lab. 

y send orders to a lab. 

y receive e-mail from the lab. 
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Getting Help 
How to Use Help 

 
  

More Help Options 
If you have a question about PROSHOTS Basics Software, you have the following options for 
obtaining help: 

Contact your PROSHOTS lab. 

Check the FAQ database (topic "Basics"). 

Talk to other photographers in the discussion forum. 

Visit the PROSHOTS Photographer Resource Center. 

Email mailto:proshotsinfo@kodak.com - You will usually receive a response within 48 hours. 

The following Web sites can offer additional support: 

JAVA Application support for MACINTOSH Systems from Apple.com 

JAVA Application support from JAVA.com 

Paid Support Option 

If you are unable to solve a problem using the above resources, you can call Kodak Technical 
Support at: 

800-235-6325, extension 45 (US customers only) 

585-588-1088 (Canada or outside the US) 

9:00 A.M. to 8:00 P.M. EST, Monday through Friday 

There is a $35 telephone support service charge for the solution to each problem. 

Photographers with current licenses for KODAK PROSHOTS Studio Software receive free 
telephone support for either PROSHOTS Studio Software or PROSHOTS Basics Software. 

 

http://www.proshots.net/resourcecenter/labs/index.php
http://faqs.kodak.com/proshot_english/topcat_16_0.shtm
http://www.proshots.net/cgi-bin/forum/login.pl?Cat=
http://www.kodak.com/global/en/professional/hub/proShots/resourcecenter/index.jhtml
mailto:proshotsinfo@kodak.com
http://www.apple.com/
http://www.java.com/
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